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Overview 
This section describes how to use the REScheckTM software.  REScheck 
is designed to demonstrate compliance with the requirements of the 
Council of American Building Officials (CABO) Model Energy Code 
(MEC) and the International Code Council (ICC) International Energy 
Conservation Code (IECC).  It is the most flexible approach for 
meeting the MEC insulation and window requirements.  The REScheck 
software runs on the Microsoft Windows operating system. 

The software demonstrates compliance with the 1992, 1993, and 1995 
editions of the MEC, the 1998, 2000, 2003, and 2006 editions of the 
IECC, the 2006 International Residential Code (IRC), and the following 
state and county residential codes:  Arkansas, Georgia, Minnesota, 
New Hampshire, New York, Vermont, Wisconsin, and Pima County, 
Arizona.  The software enables you to quickly compare different 
insulation levels in different parts of your building to arrive at a 
package that works best for you.   

REScheck is appropriate for insulation and window trade-off 
calculations in residential detached one- and two-family buildings 
(referred to as single-family buildings) and multifamily buildings 
(such as apartments, condominiums, townhouses, and rowhouses). 
 Multifamily buildings include residential buildings three stories or 
less in height with three or more attached dwelling units.   

The software generates a report that lists the insulation and window 
levels of your proposed building, as well as the additional basic 
requirements found in the code. 

REScheck performs a simple U-factor x Area (UA ) calculation for 
each building assembly to determine the overall UA of your building. 
 The UA that would result from a building conforming to the code 
requirements is compared against the UA for your building.  If the total 
heat loss (represented as a UA) through the building envelope does 
not exceed the total heat loss from the same building conforming to 
the code, then the software declares that you pass.  A high-efficiency 
equipment trade-off can also be performed. 

2006 IECC, Pima County, New Hampshire, or Georgia:  When 
any of these codes is the selected code and high-efficiency mechanical 
equipment has been entered, two separate calculations are performed 
when the Check Compliance button is clicked - the UA calculation and 
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a performance calculation based on Section 404 of the code.  The 
latter is used only when compliance by total UA fails.  

New Hampshire:  The New Hampshire Code applies to residential 
structures under four stories in height and commercial structures 
under 4,000 square feet. 

Wisconsin:  The Wisconsin Residential Code does not include 
multifamily buildings. 

Tutorials 

REScheck 101 for the 2003 IECC 

REScheck 101 for the 2006 IECC 

REScheck 201 

http://www.energycodes.gov/moodle/course/view.php?id=2
http://www.energycodes.gov/moodle/course/view.php?id=47
http://www.energycodes.gov/moodle/course/view.php?id=52


 

Table Columns and Rows 
The Envelope and Mechanical screens have grid-like tables used to 
enter and store data.  The rows and columns in the tables can be 
deleted, moved, collapsed and expanded. 

Rows  

Selecting Rows 

To select a row, click on the tree label corresponding to that row or 
click on the leftmost column of that row (the column containing row 
numbers).  The row will be highlighted when correctly selected. 

Moving Rows 

Rows can be moved by: 

1. selecting the row to be moved (as described above), 

2. releasing the mouse button, 

3. clicking and holding down the mouse button on the leftmost 
column of the selected rows, 

4. dragging the mouse to the new location - a thin red line will 
appear indicating where the row should be placed, 

5. releasing the mouse button when the red line has been placed in 
the desired location. 

A single table row can also be moved by dragging the corresponding 
row label in the tree located to the left of the table.  Click the mouse 
on the desired label and drag it to another label on the tree.  After 
releasing the mouse, the dragged label (and row) will be positioned 
directly under the label on which it was dropped.  Some restrictions 
apply to the placement of rows.  In the Envelope screen, for example, 
window and door rows can only be placed under above-grade wall or 
basement wall rows.  Skylight rows can only be placed under 
ceiling rows. 
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Collapsing and Expanding Rows 

On the Envelope screen, rows can also be collapsed and expanded by 
using the tree located to the left of the table.  Rows that fall below a 
"parent" row on the tree can be collapsed so they are not displayed. 
 For example, an exterior wall row with several windows and doors 
under it can be collapsed to hide the windows and doors.  A tree label 
with a minus sign to the left of the label is already expanded.  It can 
be collapsed by clicking on the box containing the minus sign.  Tree 
labels that are already collapsed have a plus sign to the left of the 
label.  They can be expanded by clicking the box containing the plus 
sign. 

Deleting Rows 

Rows can be deleted by selecting the row or rows to be deleted and 
selecting Delete Row(s) from the Edit menu or selecting the delete 
rows icon from the toolbar. 

  

Multiple consecutive rows can be selected by holding down the Shift 
key while clicking on the left-hand column of each desired row.  Non-
consecutive rows can be selected by holding down the Ctrl key while 
clicking on the leftmost column of each row to be selected. 

In the Envelope screen, if you delete a wall or basement row with 
windows or doors linked to it, the windows and doors will also be 
deleted.  Likewise, deleting a ceiling row with a skylight linked to it will 
cause the skylight to be deleted as well. 

Duplicating Rows 

Rows can be duplicated by selecting the row or rows to be duplicated 
and selecting Duplicate Row(s) from the Edit menu or selecting the 
duplicate rows icon from the toolbar. 

  

Multiple rows can be duplicated, but they must be consecutive. 
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Columns  

Selecting Columns 

Select a single column by clicking the left mouse button on the column 
heading.  Selected columns will be highlighted.   

Moving Columns 

Columns can be moved by: 

1. clicking the left mouse button on the column heading to be 
moved, 

2. holding down the mouse button on the column heading of any of 
the selected column, 

3. dragging the mouse to the new location where the column 
should be placed, 

4. releasing the mouse button when the column has been placed in 
the desired location. 

Changing Column Widths 

Table column widths can also be modified by moving the mouse over 
the right edge of the corresponding column header and dragging the 
column to the desired width.     

 





 

Project Information 
Your building's location, construction type (single family or 
multifamily), and other project details are entered in the Project 
screen.  The software lists the cities or counties for each state.  The 
location and construction type of your building are necessary to 
determine compliance.  If this information is not accurate, the results 
will not be valid. 

Location 

State 

To choose a different state, select the arrow button to the right of the 
field.  If a state code is selected from the Code menu, the state 
corresponding to the new code will be the only one listed.   

New Hampshire:  The New Hampshire Code applies to residential 
structures under four stories in height and commercial structures 
under 4,000 square feet.  Since the code is the same for all locations 
within the state, there are no entries for location or construction type. 

City or County 

Each time you enter a new state, the list of cities or counties changes - 
reflecting only the cities or counties located in the new state.  To 
choose a new location, select the arrow button to the right of the field. 
 A list appears containing the names of cities or counties located in the 
selected state.  If you cannot find the city in which your building will 
be located, choose a city that is close to your building site and has 
similar weather conditions. 

New Hampshire:  The New Hampshire state code is the same for the 
entire state.  If you select New Hampshire from the Code menu, the 
City/County field will disappear. 

Whenever you exit the software, the currently selected building 
location and construction type are saved.  When re-entering the 
software, the location and building characteristics fields are 
automatically updated to reflect your last entries.  Select Preferences 
from the Edit menu to change this. 
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Project Type (2006 IECC) 

When 2006 IECC is selected from the Code menu, select either New 
Construction or Addition/Alteration.  To use the addition/alteration 
feature, select Addition/Alteration as the Project Type on the Project 
screen. This project type only requires those assemblies being added 
or altered to be specified.  More info on additions   

Building Characteristics  

The code specifies different requirements for 1- and 2-family detached 
(single family) buildings and multifamily buildings, so the software 
must know which of these construction types you are going to build. 
 You must select either the 1- and 2-Family, Detached or the 
Multifamily button. 

1- and 2-Family Detached - select this for all detached one- and 
two-family dwellings.   

Multifamily - select this for all multifamily buildings that are three 
stories or less in height and contain three or more attached dwelling 
units.  Apartments, condominiums, townhouses, dormitories, and 
rowhouses are included in this category.  Multifamily buildings can be 
considered as a whole or separate reports can be generated for each 
dwelling unit.  If compliance is being shown for an individual unit, 
typically you would not include the shared components that do NOT 
separate conditioned space from unconditioned space.  Where 
individual units are identical, one report may be submitted as 
representative of the others.  Contact the authority having jurisdiction 
to determine which approach to take. 

New Hampshire:  The New Hampshire residential code applies to all 
residential structures under four (4) stories in height and commercial 
structures under 4,000 square feet.  Since the code is the same for all 
locations within the state, there are no entries for location or 
construction type.  It does not distinguish between single family and 
multifamily buildings.   

Wisconsin:  The Wisconsin code does not include multifamily 
buildings. 
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Conditioned Floor Area 

2006 IECC/Pima County, Arizona/New Hampshire/Georgia: 
 Conditioned Floor Area applies when any of these codes is selected 
from the Code menu.  If you are determining compliance to any of 
these codes, you must enter the conditioned floor area.  If this 
information is not accurate, the results will not be valid.  The 
conditioned floor area includes the gross area of all heated and/or 
cooled rooms, including the floor area of heated or cooled basements. 

Heating System Type 

Heating System Type applies when New York or Wisconsin is selected 
from the Code menu. 

New York:  The code has more stringent envelope requirements for 
buildings with electric resistance heating.  If electric resistance heating 
is used, select the Electric button.  This option should be selected for 
dwellings heated with baseboards, electric furnaces, and air-source 
heat pumps containing an electric resistance coil in the air handler 
section.  If the dwelling is heated with non-electric fossil fuel or ground 
source heat pumps, select the Non-Electric button.  For example, 
select Non-Electric for air-to-air heat pumps installed with gas backup 
that DO NOT use an electric coil backup. 

Wisconsin:  The code has more stringent requirements for electrically 
heated homes.  If the dwelling is primarily heated with electric heat 
(including electric heat pumps), select the Electric button.  If the 
dwelling is primarily heated with any other non-electric heating 
system, select the Non-Electric button. 

Project Details 

This section is entirely optional.  The Project Details section has input 
fields entitled Title/Site/Permit, Owner/Agent, Designer/Contractor, 
and Notes.  All of the information entered in these fields is included in 
your project report.  Although optional, this information may be useful 
to the building department or as a way to track and label your reports. 

New Hampshire:  The Project Details sections must be completed for 
online permitting in New Hampshire. 
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Title/Site/Permit 

Use this section to enter the project title, construction site location 
information, permit number, and permit date.   

Owner/Agent 

Use this section to enter the name and contact information for the 
building's owner/agent.   

Designer/Contractor 

Use this section to enter the name and contact information for the 
building's designer/contractor.  

Notes 

Enter any additional information in the Notes field.   

 



 

Envelope Folder 

Building Components 
The buttons on the Envelope screen are used to enter all of the 
components in your building that separate conditioned space from 
unconditioned space.  More info.  Only enter components that will 
exist in the building; you are not required to click every button.  As 
you click on the buttons, the components are added to the table on 
the Envelope screen.   

You may add as many components as you need to describe your 
building, including multiple components of the same type.  If all 
components of one type (e.g., all exterior walls) have the same 
construction characteristics (e.g., all are wood-frame, 16” o.c. with R-
13), you may add the square footage of all of those components of 
that type together and insert only one row into the table. 

For all components except slab-on-grade (entered as perimeter length 
in feet), enter the gross area of the component.  More info on 
calculating area takeoffs.  Short tutorial on calculating area takeoffs 

The status bar message at the bottom of the screen explains what 
type of information goes into the currently selected field.  To edit the 
component name, double-click in the appropriate cell in the 
Component column. 

Entries that Change Based on Location 
and/or Code Selected 

There are entries on the Envelope screen that may be included for 
certain locations and/or certain codes selected in the Code menu. 
 These items are accessible from the Options menu. 

In locations less than 3500 HDD when any of the following 
codes is selected:  1998 IECC, 2000 IECC, or 2003 IECC, or in 
any location when Pima, Arizona less than 4000 ft, Georgia, 
2006 IECC, or New Hampshire is selected:  

• Orientation (Envelope) - Select this to enable the Front Faces 
drop list for the building and create the Orientation column for 
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walls, windows, doors, and basement walls.  For walls, use the 
Orientation column to select the wall’s orientation relative to the 
front of the building.  To orient the right and left side of the 
building visualize yourself inside the building facing the front. 
 Any windows or doors entered belonging to a wall with a set 
orientation will have the same orientation as the parent wall. 

• Front Faces represents the angle of the front face of the building 
relative to North.  If the building front faces North, the building 
orientation will be 0 degrees; if the building front faces East, this 
will be 90 degrees and so on.  Select one of the eight cardinal 
points in the drop list or choose Custom.   Custom allows the 
user to specify an angle (in degrees) by rotating the building 
using a diagram.   

Locations less than 3500 HDD when 1998 IECC, 2000 IECC, or 
2003 IECC is selected:  

• Overhang Projection Factor (Envelope) - If an overhang exists, 
select this to create the Overhang Projection Factor column. 
 Enter the overhang’s projection factor (ratio of the overhang 
width to the overhang height above the window sill). 

Compliance Bar 

The software performs a simple U-factor x Area (UA) calculation for 
each building assembly to determine the overall UA of your building. 
 The UA that would result from a building conforming to the code 
requirements is compared against the UA for your building.  If the total 
UA of your building is less than or equal to the total UA of the code 
building, your building complies with the code and the Compliance field 
displays the message "Passes."  A high-efficiency equipment trade-off 
can also be performed. 

After you have filled in the information about each component, the 
program computes the UA of your proposed building and the UA of the 
code building.   

2006 IECC, Pima County, New Hampshire, or Georgia:  When 
any of these codes is the selected code, data for at least three 
components must be entered prior to compliance being determined:  a 
roof assembly, wall assembly, and floor assembly.  When at least 
those three have been entered, a Check Compliance button will 
appear.  From that point forward, each time information is changed on 
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the screen, the Check Compliance button will need to be clicked to 
obtain compliance results.   

When any of these is the selected code and high-efficiency mechanical 
equipment has been entered, two separate calculations are performed 
when the Check Compliance button is clicked - the UA calculation and 
a performance calculation based on Section 404 of the code.  The 
latter is used only when compliance by total UA fails.  If the 
performance calculation is used, you may see a dialog pop up stating 
that weather data for this location was not found.  Click OK if you have 
an active Internet connection and the weather data will be 
downloaded. 

Ceilings 
Ceilings include opaque portions of the building envelope that are 
above conditioned space and are horizontal or tilted at less than 60 
degrees from horizontal. 

Select the Ceiling button to add a ceiling component to the 
description of your design on the Envelope screen.  Each unique ceiling 
assembly should be entered as a separate component, but multiple 
ceiling elements sharing the same construction characteristics may be 
entered as one component with appropriate total area.   

Ceiling Types 

After selecting the Ceiling button, a new ceiling assembly is added to 
the table and a popup menu is displayed in the Assembly field. 
 Choose from the following ceiling types: 

• Flat Ceiling or Scissor Truss - Wood-frame ceiling structures with 
attics in which batt or loose-fill insulation is placed between and 
on top of structural ceiling members. 

• Cathedral Ceiling (no attic) - Sloped, wood-frame ceiling 
structures without attic spaces. 

• Raised or Energy Truss - Wood-frame ceiling structures with 
raised or oversized truss construction allowing the insulation to 
achieve its full thickness over the plate lines of exterior walls. 

• 2003/2006 IECC/Pima County/New Hampshire/Georgia 
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• Steel Truss - Roof/ceiling assemblies that contain 
cold-formed steel truss framing. 

• Steel Joist/Rafter, 16" o.c. - Any 16" o.c. 
roof/ceiling assembly that contains conventional C-
shaped, cold-formed steel framing. 

• Steel Joist/Rafter, 24" o.c. - Any 24" o.c. 
roof/ceiling assembly that contains conventional C-
shaped, cold-formed steel framing. 

• Structural Insulated Panels (SIPs) - Typically 4" to 6" stressed-
skin panels with foam insulation sandwiched between oriented 
strand-board (OSB).  For SIPs assemblies, you must provide the 
manufacturer-reported R-value in the Continuous Insulation 
R-Value field. 

• Other - Ceiling assemblies that do not fit into any of the other 
ceiling types, including steel-framed roofs.  If you use the Other 
ceiling type, you must enter an overall U-factor for the entire 
ceiling assembly (including air films).  Be prepared to provide 
the building department with manufacturers' literature or 
documentation of U-factor calculations. 

Ceiling Software Inputs 

• Gross Area - Enter the gross area of the ceiling component in the 
Gross Area field.  The gross ceiling area includes the area of all 
skylights within the ceiling.  You must link the ceiling to the 
skylights within that ceiling by using the tree on the left side of 
the Envelope screen.  To link a skylight to a ceiling assembly, 
drag the skylight label on the tree to the ceiling label and release 
the mouse.  The ceiling area should be measured on the slope of 
the finished interior surface. 

• Cavity Insulation R-Value - Enter the R-value of any insulation 
to be installed in the cavities between ceiling structural 
members, including all blown insulation.  The insulating values of 
other parts of the building assemblies (e.g., gypsum board and 
air films) are accounted for by the program and should not be 
included. 

• Continuous Insulation R-Value - Enter the R-value of any 
continuous ceiling insulation.  Continuous insulation is 
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insulation that runs continuously over structural members and is 
free of significant thermal bridging; such as rigid foam insulation 
above the ceiling deck.  For ventilated ceilings, insulating 
sheathing must be placed between the conditioned space and 
the ventilated portion of the ceiling (typically applied to the 
trusses or rafters immediately behind the drywall or other ceiling 
finish material).  For structural insulated panels, enter the 
manufacturer-reported R-value for the entire assembly. 

• Assembly U-Factor - If you have selected the Other ceiling type 
option, enter the overall U-factor of the ceiling assembly 
including exterior and interior air films.  Do not include the 
finished ceiling in the U-factor calculation if the space between 
ceiling and ceiling structure is used as an HVAC plenum. 
 Building departments may require supporting documentation for 
assemblies entered using the Other ceiling type and U-Factor 
field. 

Skylights 
Skylights are defined as any transparent or translucent section in a 
building ceiling.  Glazing having a slope less than 60 degrees from 
horizontal is considered a skylight , while glazing having a slope 
greater than 60 degrees from horizontal is considered a window. 

Click the Skylight button to add a skylight component to the 
description of your design on the Envelope screen.  Each unique 
skylight assembly should be entered as a separate component, but 
multiple skylight elements having the same characteristics may be 
entered as one component with the appropriate total area.   

Skylights must be linked to their corresponding ceiling component. 
 Link a skylight to a ceiling by using the tree on the left side of the 
Envelope screen.  Drag the skylight label on the tree to the ceiling 
label and release the mouse. 

Skylight Types 

• Frame Type - The frame type enables you to identify the skylight 
frame material.  Use Other for frame types that do not fit into 
any of the other frame types.   
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• Glazing Layers - The glazing layers field enables you to identify 
the number of glazing layers in the skylights (i.e., single, double, 
or triple).  Double Pane with Low-E is included because the 
performance impact of low-emissivity films is similar to that of 
additional glass layers. 

Skylight Software Inputs 

• Gross Area - Enter the area of the entire skylight component in 
square feet (ft2) in the Gross Area field.  Skylight area is the 
interior surface area of the entire assembly, including glazing 
and framing elements.  The nominal area or rough opening is 
also acceptable.   

• U-Factor - Enter the U-factor for each component in its 
corresponding U-Factor field.  U-factors for glazing must be 
tested and documented by the manufacturer in accordance with 
the NFRC test procedure or taken from the default glazing U-
factors table in default tables.  Center-of-glass U-factors cannot 
be used.     

• SHGC - this input will appear in certain locations or when certain 
codes are selected in the Code menu.  The Solar Heat Gain 
Coefficient enables you to specify the glazing’s effectiveness in 
rejecting solar heat gain.  SHGC is part of a system for rating 
glazing performance used by the National Fenestration Rating 
Council (NFRC).  [Will appear in locations less than 3500 
HDD when any of the following codes is selected: 1998 
IECC, 2000 IECC, or 2003 IECC, or in climate zones 1-3 
(not 3 marine) when Pima County, Arizona 2006 IECC less 
than 4000 ft, Georgia, 2006 IECC, or New Hampshire is 
selected.]  

Walls 
Select the Wall button to add an above-grade wall component to the 
description of your design on the Envelope screen.  Each unique 
above-grade wall assembly should be entered as a separate 
component, but multiple wall elements sharing the same construction 
may be entered as one component with appropriate total area.  
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Wall Types 

• Wood Frame, 16" o.c. - Wood frame walls with 16" on-center 
stud spacing.  The category is intended primarily for light-weight 
walls but may also be used for walls with masonry veneers. 

• Wood Frame, 24" o.c. - Wood frame walls with 24" on-center 
stud spacing.  The category is intended primarily for light-weight 
walls but may also be used for walls with masonry veneers. 

• Steel Frame, 16" o.c. - Steel frame (stud) walls of any gauge or 
depth, with 16" on-center stud spacing.  The category is 
intended primarily for light-weight walls but may also be used 
for walls with masonry veneers.  

• Steel Frame, 24" o.c. - Steel frame (stud) walls of any gauge or 
depth, with 24" on-center stud spacing.  The category is 
intended primarily for light-weight walls but may also be used 
for walls with masonry veneers. 

• Solid Concrete or Masonry - Solid precast or poured-in-place 
concrete as well as concrete masonry units with grouted cells. 
 In making this selection, you must also indicate whether the 
insulation will be located on the interior or exterior of the wall. 
 If insulation will be placed on both the interior and exterior of 
the wall, select the option corresponding to the larger insulative 
R-value.  For example, if R-5 exterior sheathing will be used 
with R-13 interior cavity insulation on a furred out concrete 
wall, select the Interior Insulation option.  To receive full credit 
for light-weight (insulated) concrete walls, use the Other wall 
type. 

• Masonry Block with Empty Cells - Concrete masonry block units 
with at least 50% of the cells free of grout.  In making this 
selection, you must also indicate whether the insulation will be 
located on the interior or exterior of the wall.  If insulation will 
be placed on both the interior and exterior of the wall, select the 
option corresponding to the larger insulative R-value.  To receive 
full credit for light-weight (insulated) concrete walls, use the 
Other wall type.   

• Masonry Block with Integral Insulation - Concrete masonry block 
units with integral insulation, such as perlite or rigid foam 
inserts.  Integral insulation means insulation placed within the 
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cells.  Selecting this wall type gives you credit for integral 
insulation.  DO NOT enter values for cavity R-value and 
continuous R-value unless additional insulation will be installed. 
 In making this selection, you must also indicate whether the 
additional insulation will be located on the interior or exterior of 
the wall.  If additional insulation will be placed on both the 
interior and exterior of the wall, select the option corresponding 
to the larger insulative R-value.  To receive full credit for light-
weight (insulated) concrete walls, use the Other wall type. 

• Log - Walls constructed from 5" or larger nominal width logs. 
 Select the applicable wood species and the log thickness 
(nominal width) from the lists.  See the list of wood species at 
the bottom of this page. 

 

NOTE: Concrete, masonry, and "qualifying" log walls receive a mass 
wall credit in some locations.  In order to qualify for this credit, the 
heat capacity of the exterior wall must be greater than or equal to 6 
Btu/ft2 °F [123 kj/m2 °K] of exterior wall area.  Masonry and concrete 
walls having a mass greater than or equal to 30 lb/ft2 of exterior wall 
area (146 kg/m2) will meet this requirement.  Masonry and concrete 

18 



Envelope Folder 

walls with lesser mass should be entered as wood-framed walls.  For 
log walls, the heat capacity will be dependent on the specified wood 
species and nominal width.  The insulating value of the logs 
themselves is accounted for in the software.  You should only enter a 
cavity R-value if there is additional insulation being used.   

Vermont:  The Vermont residential code has lesser overall 
thermal envelope requirements but greater heating system 
efficiency requirements for log wall homes.  Contact the 
Department of Public Service to find out more about log 
homes and their requirements. 

• Structural Insulated Panels - Typically 4" to 6" stressed-skin 
panels with foam insulation sandwiched between oriented 
strand-board (OSB).  For SIPs assemblies, you must provide the 
manufacturer-reported R-value in the Continuous Insulation R-
Value field. 

• Insulated Concrete Forms - ICFs are insulating, stay-in-place 
forms for poured concrete walls.  The forms, which remain a 
permanent part of the wall assembly, are either pre-formed 
interlocking blocks or separate panels connected with plastic 
ties.  For ICF systems, you must provide the manufacturer-
reported R-value in the Continuous Insulation R-Value field.  This 
R-value should include air films and all materials used in the 
assembly, including insulation but excluding soil effects.  The 
effects of mortar joints and steel framing reinforcement that 
penetrates insulation must be included.  Do NOT enter the R-
value of the insulation only.  To determine the total assembly R-
value, manufacturers may use the Series-Parallel method 
described in the ASHRAE Fundamentals Handbook or may 
provide third-party independent test results from a physical 
testing laboratory.  Acceptable physical testing procedures 
include ASTM C177, ASTM C518, ASTM C236 or ASTM C976. 
 Tested R-value results should be included with permit 
submittals. 

• Other - Wall assemblies that do not fit into any of the other 
above-grade wall types.  Also use the Other wall type to receive 
full credit for the extra insulative value of light-weight 
(insulated) concrete walls.  You must enter an overall U-factor 
for the entire wall assembly (including air films).  Be prepared to 
provide the building department with manufacturers' literature or 
documentation of U-factor calculations.   
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Wisconsin:  Assembly U-factors entered under the Other 
wall type must be approved through the Department of 
Commerce. 

Wall Software Inputs 

• Gross Area - Enter the gross area of the wall component in the 
Gross Area field.  The gross wall area includes the area of all 
windows and doors within the wall.  You must link the wall to the 
windows and doors within that wall by using the tree on the left 
side of the Envelope screen.  To link a window or door to a wall, 
drag the window or door label on the tree to the wall label and 
release the mouse.  The gross wall area also includes the 
peripheral edges of floors (the area of the band joist and 
subfloor between floors).    

The gross area of any individual wall of a conditioned basement 
with an average depth less than 50% below grade should be 
entered as a wall (not as a basement).  In this case, the gross 
wall area includes the below-grade portion of the wall and the 
areas of doors and windows within those walls. 

• Cavity Insulation R-Value - Enter the R-value of any insulation to 
be installed in the cavities between above-grade wall structural 
members.  The insulating values of other parts of the building 
assembly (e.g., gypsum board and air films) are accounted for 
by the program and should not be included.   

• Continuous Insulation R-Value - Enter the R-value of any 
continuous insulation in the above-grade wall.  Continuous 
insulation is continuous over framing members or furring strips 
and is free of significant thermal bridging.  The R-values of other 
parts of the building assembly (e.g., gypsum board and air films) 
are accounted for by the program and should not be entered. 
 Insulating sheathing installed on the exterior of above-grade 
walls is an example of continuous insulation.  For structural 
insulated panels and insulated concrete forms, enter the 
manufacturer-reported R-value for the entire assembly.     

• Assembly U-Factor - If you have selected the Other wall type, 
enter the overall U-factor of the above-grade wall assembly 
including exterior and interior air films.  Building departments 
may require supporting documentation for assemblies entered 
using the Other wall type and U-Factor field.  
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• Orientation - this input will appear for certain locations or when 
certain codes are selected in the Code menu.  See Options Menu 
 [Will appear in locations less than 3500 HDD when any of 
the following codes is selected:  1998 IECC, 2000 IECC, or 
2003 IECC, or any location when Pima County, Arizona, 
Georgia, 2006 IECC, or New Hampshire is selected.]    

Log Wood Species 

Species Abbreviation Species Abbreviation 

Baldcypress CYP Red-
Canadian 
Pine 

RP-N 

Douglas 
Fir-Larch 

DFL Shortleaf 
Pine 

SLP 

E. Spruce-
Pine-Fir 

ESPF Slash Pine SHP 

Eastern 
Softwoods 

ESW Southern 
Pine 

SP 

Eastern 
Spruce 

ES Sugar 
Pine 

SUP 

Eastern 
White Pine 

EWP Tamarack TAM 

Hem-Fir HF W. 
Spruce-
Pine-Fir 

WSPF 

Incense 
Cedar 

IC Western 
Red 

WRC-N 
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Canadian 
Cedar 

Loblolly 
Pine 

LBP Western 
Red Cedar 

WRC 

Longleaf 
Pine 

LLP Western 
Softwoods 

WS 

Mixed 
Southern 
Pine 

MSP Western 
White 
Pine 

WWP 

Ponderosa 
Pine 

PP White 
Cedar 

WC 

Red Cedar RC White Fir WF 

Red Oak RO White 
Oak 

WO 

Red Pine RP Yellow 
Cedar 

YC 

 

Windows 
Windows are defined as any transparent or translucent section in an 
exterior building wall including glass block but excluding glass doors 
(which are entered using the Door button).  Glazing having a slope 
greater than 60 degrees from horizontal is considered a window while 
glazing having a slope less than 60 degrees from horizontal is 
considered a skylight. 

Click the Window button to add a window component to the 
description of your design on the Envelope screen.  Each unique 
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window assembly should be entered as a separate component, but 
multiple window elements having the same characteristics may be 
entered as one component with an appropriate total area.    

Windows must be linked to their corresponding wall component.  Link 
a window to a wall by using the tree label on the left side of the 
Envelope screen.  Drag the window or door label on the tree to the 
wall label and release the mouse.   Windows in the exterior walls of 
conditioned basements should be included in the table and should be 
linked to their corresponding basement wall assembly.  Windows in 
unconditioned basements are NOT included.   

Window Types 

• Frame Type - The frame type enables you to identify the window 
frame material.  Use Other for frame types that do not fit into 
any of the other frame types. 

• Glazing Layers - The glazing layers enables you to identify the 
number of glazing layers in the windows (i.e., single, double, or 
triple).  Double Pane with Low-E is included because the 
performance impact of low-emissivity films is similar to that of 
additional glass layers. 

Window Software Inputs 

• Gross Area - Enter the area of the entire window component in 
square feet (ft2) in the Gross Area field.  Window area is the 
interior surface area of the entire assembly, including glazing, 
sash, curbing, and other framing elements.  The nominal area or 
rough opening is also acceptable for flat windows.   

• 2006 IECC, Pima County, New Hampshire, or 
Georgia:  When any of these codes is the selected code, 
the software will automatically exempt 15 ft2 total of 
glazed fenestration area entered by the user as per the 
code.   

• U-Factor - Enter the U-factor for each component in its 
corresponding U-Factor field.  U-factors for glazing must be 
tested and documented by the manufacturer in accordance with 
the NFRC test procedure or taken from the default glazing U-
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factors table in the default tables.  Center-of-glass U-factors 
cannot be used. 

Minnesota:  The Minnesota residential code further requires 
that the area-weighted average U-factor of all foundation 
windows 5.6 ft2 and less not exceed 0.51.  The area-
weighted average U-factor of all skylights may not exceed 
0.55.  The area-weighted average U-factor for all other 
windows and sliding glass doors may not exceed 0.37. 

• SHGC - this input will appear for certain locations or when 
certain codes are selected in the Code menu.  The Solar Heat 
Gain Coefficient enables you to specify the glazing’s 
effectiveness in rejecting solar heat gain.  SHGC is part of a 
system for rating glazing performance used by the National 
Fenestration Rating Council (NFRC).  [Will appear in locations 
less than 3500 HDD when any of the following codes is 
selected: 1998 IECC , 2000 IECC, or 2003 IECC, or in 
climate zones 1-3 (not 3 marine) when Pima County, 
Arizona 2006 IECC less than 4000 ft, Georgia, 2006 IECC, 
or New Hampshire is selected.]  

• Orientation - this input will appear for certain locations or when 
certain codes are selected in the Code menu.  Orientation - see 
Options Menu  [Will appear in locations less than 3500 HDD 
when any of the following codes is selected:  1998 IECC, 
2000 IECC, or 2003 IECC, or any location when Pima 
County, Arizona, 2006 IECC, Georgia, or New Hampshire is 
selected.]  

Doors 
Click the Door button to add a door component to the description of 
your design on the Envelope screen.  Each unique door assembly 
should be entered as a separate component, but multiple door 
elements sharing the same construction may be entered as one 
component with the appropriate total area.  

Door Types 

• Solid (under 50% glazing ) - Exterior doors that are mostly 
opaque (i.e., glass covers 50% or less of the door's area). 
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• Glass (over 50% glazing) - Exterior doors that are mostly glazed 
(i.e., glass covers more than 50% of the door's area). 

• Sidelites:  Decorative door sidelites can be included with the 
door area and U-factor if an aggregate U-factor is known for the 
entire assembly (the door plus all sidelites).  If the U-factor 
rating does not include the sidelites, enter the sidelites 
separately as windows and use a default glazing U-factor from 
the default tables. 

Door Software Inputs 

• Gross Area - Enter the total area of the door in square feet (ft2) 
including any glazed portions in the Gross Area field.  The 
nominal area or rough opening is also acceptable.   

• 2006 IECC, Pima County, New Hampshire, or 
Georgia:  When any of these codes is the selected code, 
the software will automatically exempt one opaque door 
(up to 40 ft2) entered by the user as per the code.  The 
door with the highest U-factor is exempted.  In 
combination with other glazed fenestration entered by the 
user, up to 15 ft2 total of glazed fenestration will be 
automatically exempted by the software as per the code.    

• U-Factor - Door U-factors must be tested and documented by 
the manufacturer in accordance with the NFRC test procedure or 
taken from the default door U-factors table. 

• SHGC - this input will appear for certain locations or when 
certain codes are selected in the Code menu.  For glass doors, 
the Solar Heat Gain Coefficient enables you to specify the 
glazing’s effectiveness in rejecting solar heat gain.  SHGC is part 
of a system for rating glazing performance used by the National 
Fenestration Rating Council (NFRC).  [Will appear in locations 
less than 3500 HDD when any of the following codes is 
selected:  1998 IECC , 2000 IECC, or 2003 IECC, or in 
climate zones 1-3 (not 3 marine) when Pima County, 
Arizona 2006 IECC less than 4000 ft,  Georgia, 2006 IECC, 
or New Hampshire is selected.]     

• Orientation - this input will appear for certain locations or when 
certain codes are selected in the Code menu.  Orientation - see 
Options Menu  [Will appear in locations less than 3500 HDD 
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when any of the following is selected:  1998 IECC, 2000 
IECC, or 2003 IECC, or in any location when Pima County, 
Arizona,  Georgia, 2006 IECC, or New Hampshire is 
selected.]   

If the door is rated with an aggregate R-value (an R-value that 
includes both the glass and opaque area), the following equation 
applies: 

  

If an opaque door contains glass and an aggregate R-value or U-factor 
rating for that door is not available, enter the door's glass area as a 
separate glazing component, enter the opaque area as an opaque door 
component, and enter an opaque door U-factor taken from the default 
tables.  The U-factors listed in the default tables are only for doors 
without glass. 

Basements 
Any individual wall of a conditioned basement with an average depth 
50% or more below grade should be entered using the Basement 
button.  Walls of conditioned basements with an average depth LESS 
than 50% below grade should be entered as an above-grade wall using 
the Wall button. 

Click the Basement button to add a basement wall component to the 
description of your design on the Envelope screen.  Each unique 
basement wall assembly should be entered as a separate component, 
but multiple basement wall elements sharing the same construction 
may be entered as one component with the appropriate total area. 

2000/2003/2006 IECC require exterior foundation wall insulation to 
have a rigid, opaque, and weather-resistant covering that prevents the 
degradation of the insulation's performance.  The protective covering 
must cover the exposed (above-grade) area of the insulation and 
extend to a minimum of 6 in. (153 mm) below grade.   

Basement Wall Types 

• Solid Concrete or Masonry - Solid precast or poured-in-place 
concrete as well as concrete masonry units with grouted cells. 

26 



Envelope Folder 

 To receive full credit for light-weight (insulated) concrete walls, 
use the Other basement wall type.   

• Masonry Block with Empty Cells - Concrete masonry block units 
with at least 50% of the cells free of grout.  To receive full credit 
for light-weight (insulated) concrete walls, use the Other 
basement wall type.   

• Masonry Block with Integral Insulation - Concrete masonry block 
units with integral insulation, such as perlite or rigid foam 
inserts.  Integral insulation means insulation placed within the 
cells.  Selecting this wall type gives you credit for integral 
insulation.  DO NOT enter values for cavity R-value and 
continuous R-value unless additional insulation will be installed. 
 To receive full credit for light-weight (insulated) concrete walls, 
use the Other basement wall type.    

• Wood Frame - Wood-frame walls with any stud spacing. 

• Insulated Concrete Forms - ICFs are insulating, stay-in-place 
forms for poured concrete walls.  The forms, which remain a 
permanent part of the wall assembly, are either pre-formed 
interlocking blocks or separate panels connected with plastic 
ties.  For ICF systems, you must provide the manufacturer-
reported R-value in the Continuous Insulation R-Value field.  The 
assembly R-value should include air films and all materials used 
in the assembly, including insulation but excluding soil effects. 
 The effects of mortar joints and steel framing reinforcement 
that penetrates insulation must be included.  Do NOT enter only 
the R-value of the insulation.  To determine the total assembly 
R-value, manufacturers may use the Series-Parallel method 
described in the ASHRAE Fundamentals Handbook, or may 
provide third-party independent test results from a physical 
testing laboratory.  Acceptable physical testing procedures 
include ASTM C177, ASTM C518, ASTM C236 or ASTM C976. 
 Tested R-value results should be included with permit 
submittals.  
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• Other - Basement wall assemblies that do not fit into any of the 
other basement wall types.  Also use the Other basement wall 
type to receive full credit for the extra insulative value of light-
weight (insulated) concrete walls.  If you use the Other 
basement wall type, you must enter an overall U-factor for the 
entire wall assembly (including interior air film but excluding 
earth).  Be prepared to provide U-factor calculations or 
documentation from manufacturer's literature to the building 
department.   

Wisconsin:  Assembly U-factors entered under the Other 
wall type must be approved through the Department of 
Commerce. 

Basement Software Inputs 

After selecting a basement wall type, a basement wall illustration will 
appear with input boxes for the basement wall height, depth below 
grade, and depth of insulation.  The illustration helps identify the 
dimensions being requested.  You may enter basement wall 
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dimensions directly into this illustration and select the OK button to 
have them transferred to the corresponding row in the table on the 
Envelope screen.  If you prefer to enter the dimensions directly into 
the table on the Envelope screen, you can select Cancel to remove the 
illustration without entering dimensions.  To view the basement wall 
illustration and inputs at a later time, click the right-mouse button 
anywhere on the basement row and select Edit Basement Inputs from 
the popup menu. 

  

• Wall Height - Provide the height of the wall (ft) as measured 
from the top of the wall to basement floor.  If the height is not 
uniform, provide an average height.  If you are entering a partial 
basement wall component (such as wood kneewalls), enter the 
height of the wall section instead of the height of the entire wall. 

• Depth Below Grade - Provide the depth (ft) that the wall extends 
from the finished outside grade surface to the basement floor.  If 
the grade is sloped or uneven, provide an average depth below 
grade.  If you are entering a partial basement wall component 
(such as wood kneewalls), enter the depth below grade of the 
wall section instead of the depth below grade of the entire wall. 
 For wood kneewalls, the wall section may be entirely above 
grade, in which case you would enter 0. 
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• Depth of Insulation - Basement insulation requirements are for 
the full depth of the basement wall (up to 10 ft).  REScheck, 
however, allows the depth of the basement wall insulation to be 
traded against other envelope components.  Therefore, you must 
indicate the depth (ft) of the insulation you intend to install on 
your basement wall as measured from the top of the wall to 
where the insulation stops.  The insulation must extend from the 
top of the basement wall downward to a depth equal to the value 
entered in this field.  Note that for a fully insulated wall the 
depth of insulation should be equal to the height of the wall.  For 
basement walls with non-uniform insulation depths, enter an 
average.  REScheck accepts basement insulation depths from 0 
to 12 ft.  If you enter an insulation depth of 0, the program 
assumes no insulation is installed regardless of the values in the 
Cavity Insulation R-Value and Continuous Insulation R-Value 
fields. 

• Gross Area - Enter the gross area of the basement wall 
component in the Gross Area field.  The gross basement wall 
area includes the area of all windows and doors within the wall. 
 You must link the wall to the windows and doors within that wall 
by using the tree on the left side of the Envelope screen.  To link 
a window or door to a wall, drag the window or door label on the 
tree to the wall label and release the mouse. 

The gross area of any individual wall of a conditioned basement 
with an average depth less than 50% below grade should be 
entered as a wall (not as a basement). 

• Cavity Insulation R-Value - If the basement will be furred, 
provide the R-value of the insulation to be installed between 
furring in the Cavity Insulation R-Value field.  Do not include the 
R-value of other materials (such as interior drywall). 

• Continuous Insulation R-Value - Enter continuous insulation in 
the Continuous Insulation R-Value field.  Continuous insulation 
includes exterior rigid foam products and any continuous 
insulation installed on the exterior or interior of an unfurred 
basement wall.  For ICFs, enter the manufacturer-reported R-
value for the entire assembly in the Continuous Insulation R-
Value field. 

Minnesota:  R-5 is the minimum basement wall insulation R-value 
allowed by the Minnesota residential code. 
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Orientation - this input will appear for certain locations or when certain 
codes are selected in the Code menu.  Orientation - see Options Menu 
 [Will appear in locations less than 3500 HDD when any of the 
following is selected:  1998 IECC, 2000 IECC, or 2003 IECC, or 
in any location when Pima County, Arizona, Georgia, 2006 
IECC, or New Hampshire is selected.]   

Example 1:  Wood Kneewalls 

Assume a basement is to be constructed with 3-ft-high wood kneewalls 
built on a 5-ft-high concrete foundation.  R-13 insulation will be 
installed in the wood kneewall cavities and R-5 rigid insulation will be 
installed on the concrete foundation walls. 

The wood kneewalls are completely above grade and fully insulated. 
 The concrete foundation walls are 4 ft below grade and fully insulated. 

Create one basement wall component for the wood kneewalls and 
enter the following information: 

• Wall Height     3 ft. 

• Depth Below Grade    0 ft. 

• Depth of Insulation    3 ft. 

Create a second basement wall component for the concrete foundation 
and enter the following information: 

• Wall Height     5 ft. 

• Depth Below Grade    4 ft. 

• Depth of Insulation    5 ft. 

Two basement wall components will be added to your list of building 
components.  Provide the gross wall area of the wood kneewalls and 
enter the insulation R-value as R-13 in the Cavity Insulation R-Value 
field.  Provide the gross wall area of the concrete foundation walls and 
enter the continuous R-value as R-5 in the Continuous Insulation R-
Value field. 

Example 2:  Walk-Out Basement 
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Assume an 8-ft. basement is to be built on a slope so that the front 
wall is 7 ft. below grade and the rear wall is totally above grade.  The 
ground level along both side walls is sloped so that approximately 50% 
of each wall is below grade.  The rear basement wall will be wood-
frame construction with R-19 cavity insulation.  The other three 
walls will be concrete walls with R-10 rigid insulation.  All four walls 
will be fully insulated. 

Create one basement component for the front wall and enter the 
following information: 

• Wall Height     8 ft. 

• Depth Below Grade    7 ft. 

• Depth of Insulation    8 ft. 

The two side walls are at least 50% below grade, so they are entered 
as a basement wall component.  If they were less than 50% below 
grade, they would be entered as an above-grade wall component. 
 Therefore, create a second basement wall component for the two side 
walls and enter the following information: 

• Wall Height     8 ft. 

• Depth Below Grade    4 ft. 

• Depth of Insulation    8 ft. 

The rear wall is fully above grade and should be entered as an above-
grade wall using the Wall button.  Note that the basement floor along 
this wall should be considered a slab-on-grade component.  Create a 
slab component using the Floor button and enter the length of the 
basement floor along this wall in the Gross Area or Slab Perimeter 
field. 

Example 3:  Below-Grade Exterior Insulation 

An 8-ft. high by 21-ft. wide foundation wall is 7 ft. below grade and is 
to be insulated using R-5 exterior rigid foam.  The insulation will start 
at grade level and run down to the bottom of the foundation wall. 
 There is 1 foot of uninsulated exposed above-grade wall.  The wall has 
no openings. 
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This wall is entered in REScheck by creating two basement wall 
components.  The first component will be used for entering the 
uninsulated above-grade portion of the wall. 

Click the Basement button and enter the following information: 

• Wall Height     1 ft. 

• Depth Below Grade    0 ft. 

• Depth of Insulation    0 ft. 

The second component will be used for entering the insulated below-
grade portion of the wall.  Click the Basement button again and enter 
the following information: 

• Wall Height     7 ft. 

• Depth Below Grade    7 ft. 

• Depth of Insulation    7 ft. 

After these components have been created, enter the gross area of 
each component and the R-value of the insulation used on the below-
grade component.   
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Example 4:  Draped Interior Insulation 

Some builders choose to insulate the interior of basement walls with 
faced insulation batts.  Some products have reinforced stapling tabs at 
the top and bottom of the batts for installation on furring strips using a 
hammer-stapler.  They might also be power-nailed directly to a solid 
concrete or block wall or installed on pins glued directly to the 
foundation wall.  The batts typically come in 4-ft. wide rolls, and are 
sometimes installed on only the top 4 ft. of the wall. 

A solid concrete basement has 10-ft. high walls and is buried 9 ft. 
below grade.  Foil faced, R-11 (4-ft. wide roll) basement batt 
insulation is to be installed horizontally on the upper 4 ft. of the 
interior of the basement walls.  Click the Basement button, select the 
Solid Concrete or Masonry option, and enter the following information: 

• Wall Height     10 ft. 

• Depth Below Grade    9 ft. 

• Depth of Insulation    4 ft. 

With these inputs, the software will assume the lower 6 ft. of the wall 
is uninsulated.  The R-value of the uninsulated concrete wall is 
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provided by the software and should not be entered by the user.  After 
the basement component has been created, enter the sum of the 
gross area of all exterior basement walls in the Gross Area field and 
enter the assembly R-value (R-11) in the Continuous Insulation R-
Value field.  Note that the gross area equals the sum of the insulated 
and uninsulated areas.  If additional rows of batt insulation are 
installed to cover the lower 4-ft. of the basement wall or the batt roll is 
installed in vertical strips, then the insulation R-value should be 
entered in the Cavity Insulation R-Value field because there will be 
breaks in the insulation at the joints between the batts. 

Floors 
Click the Floor button to add a floor component to the description of 
your design on the Envelope screen.  Each unique exposed floor 
assembly should be entered as a separate component, but multiple 
floor elements sharing the same construction may be entered as one 
component with the appropriate total area.  Slab-on-grade 
components include all slab edges that are part of the building 
envelope and are less than 12" below grade (i.e., all edges separating 
conditioned from unconditioned space).  Edges of slab floors over 
12" below grade (such as basement floors) are not subject to code 
requirements and do not need to be entered in the software.  Each 
unique concrete slab/insulation combination (i.e., insulation R-value 
and depth) should be entered separately, but all slabs sharing 
insulation methods may be entered as a single component with the 
appropriate total perimeter length. 

2000/2003/2006 IECC require slab perimeter insulation to have a 
rigid, opaque, and weather-resistant covering that prevents the 
degradation of the insulation’s performance.  The protective covering 
must cover the exposed (above-grade) area of the insulation and 
extend to a minimum of 6 inches (153 mm) below grade. 

Floor Types 

• All-Wood Joist/Truss - Any structural wood floor in which 
insulation is placed between the structural members; e.g., batt 
insulation between wood floor joists. 

• 2003/2006 IECC/Pima County/New Hampshire/Georgia 
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• Steel Frame, 16" o.c. - Any 16" o.c. floor assembly 
that contains C-shaped, cold-formed steel framing. 

• Steel Frame, 24" o.c. - Any 24" o.c. floor assembly 
that contains C-shaped, cold-formed steel framing. 

• Slab-On-Grade Unheated - A slab that is not heated. 

• Slab-On-Grade Heated - A heated slab is one in which the 
heating elements or hot air distribution system is in contact with 
or placed within the slab or subgrade.  Heated slabs have higher 
insulation requirements than unheated slabs under the code. 

Minnesota:  R-5 is the minimum slab perimeter insulation 
R-value allowed by the Minnesota residential code. 

• Structural Insulated Panels - Typically 4" to 6" stressed-skin 
panels with foam insulation sandwiched between oriented 
strand-board (OSB).  For SIPs assemblies, you must provide the 
manufacturer-reported R-value in the Continuous Insulation R-
value field. 

• Other - Floor assemblies that do not fit into any of the other floor 
types. You must enter an overall U-factor for the entire floor 
assembly (including air films).  Be prepared to provide the 
building department with manufacturers' literature or 
documentation of U-factor calculations. 

• Floor Location - For some floor types you must also indicate 
whether the floor is located over an unconditioned space or over 
outside air.  Floors over unconditioned space include all floors 
over unconditioned (neither heated nor cooled) basements, 
crawl spaces, and garages.  Floors over outside air include floor 
cantilevers, floors of an elevated home, and floors over 
overhangs (such as the floor directly above a recessed entryway 
or open carport).  Floors over heated spaces are not part of the 
building envelope and should not be included.   

Floor Software Inputs 

• Gross Area or Slab Perimeter - Enter the gross area of the floor 
(in square feet) along the boundary where it separates 
conditioned from unconditioned space.  For slabs-on-grade, 
enter the perimeter (in linear feet) which should include the 
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• Cavity Insulation R-Value - Enter the R-value of any insulation 
to be installed in the cavities between floor structural members. 
 The insulating values of other parts of the building assembly 
(e.g., subfloor and air films) are accounted for by the program.   

• Continuous Insulation R-Value - Enter the R-value of any 
continuous floor insulation.  Continuous insulation is insulation 
that runs continuously over structural members and is free of 
significant thermal bridging.  The insulating values of other parts 
of the building assembly (e.g., subfloor and air films) are 
accounted for by the program.  For slabs, enter the R-value of 
the slab perimeter insulation. 

• Assembly U-Factor - If you have selected the Other floor type 
option, you must enter the overall U-factor of the floor assembly 
including exterior and interior air films.  Building departments 
may require supporting documentation for assemblies entered 
using the Other floor type and U-Factor field. 

• Depth of Insulation - Enter the depth (ft) of the insulation you 
intend to install as measured from the top of the slab to where 
the insulation stops.  This distance should include the total 
vertical plus horizontal distance.  Refer to the illustration below 
of acceptable configurations.  If you enter a depth of 0, the 
program assumes no insulation is to be installed.  

After selecting a slab type, an illustration of various slab configurations 
will appear with an input box for the depth of insulation.  The 
illustration helps identify the dimension being requested for various 
insulation configurations.  You may enter the depth of insulation 
directly into this illustration and select the OK button to have it 
transferred to the corresponding row in the table on the Envelope 
screen.  If you prefer to enter the insulation depth directly into the 
table on the Envelope screen, you can select Cancel to remove the 
illustration without entering a value.  To view the slab illustration at a 
later time, click the right-mouse button anywhere on the slab row and 
select Edit Slab Inputs from the popup menu. 
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Crawl Space Walls 
The crawl space wall option is for walls of unventilated crawl spaces 
(i.e. not directly vented to the outside).  If you are insulating the floor 
above the crawl space, do not use the crawl space walls option.   

Click the Crawl Wall button to add a crawl space wall component to the 
description of your design on the Envelope screen.  Each unique crawl 
space wall assembly should be entered as a separate component, but 
multiple crawl space wall elements sharing the same construction may 
be entered as one component with the appropriate total area. 
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Crawl Space Wall Types 

• Solid Concrete or Masonry - Solid precast or poured-in-place 
concrete as well as concrete masonry units with grouted cells. 
 To receive full credit for light-weight (insulated) concrete walls, 
use the Other crawl space wall type.   

• Masonry Block with Empty Cells - Concrete masonry block units 
with at least 50% of the cells free of grout.  To receive full credit 
for light-weight (insulated) concrete walls, use the Other crawl 
space wall type.   

• Masonry Block with Integral Insulation - Concrete masonry block 
units with integral insulation, such as perlite or rigid foam 
inserts.  Integral insulation means insulation placed within the 
cells.  Selecting this wall type gives you credit for integral 
insulation.  DO NOT enter values for cavity R-value and 
continuous R-value unless additional insulation will be installed. 
 To receive full credit for light-weight (insulated) concrete walls, 
use the Other crawl space wall type.   

• Wood Frame - Wood-frame walls with any stud spacing. 

• Insulated Concrete Forms - ICFs are insulating, stay-in-place 
forms for poured concrete walls.  The forms, which remain a 
permanent part of the wall assembly, are either pre-formed 
interlocking blocks or separate panels connected with plastic 
ties.  For ICF systems, you must provide the manufacturer-
reported R-value in the Continuous R-Value field. 

• Other - Crawl space wall assemblies that do not fit into any of 
the other crawl space wall types.  Also use the Other crawl space 
wall type to receive full credit for the extra insulative value of 
light-weight (insulated) concrete walls.  If you use the Other 
crawl space wall type, you must enter an overall U-factor for 
the entire wall assembly (including interior air film but excluding 
earth).  Be prepared to provide U-factor calculations or 
documentation from manufacturer's literature to the building 
department.   
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Crawl Space Wall Software Inputs 

After selecting a crawl space wall type, a crawl space wall illustration 
will appear with input boxes for the crawl space wall height, depth 
below grade, depth of insulation, and depth below inside grade.  The 
illustration helps identify the dimensions being requested.  You may 
enter crawl space wall dimensions directly into this illustration and 
select the OK button to have them transferred to the corresponding 
row in the table on the Envelope screen.  If you prefer to enter the 
dimensions directly into the table on the Envelope screen, you can 
select Cancel to remove the illustration without entering dimensions. 
 To view the crawl space wall illustration and inputs at a later time, 
click the right-mouse button anywhere on the crawl space row and 
select Edit Crawl Inputs from the popup menu. 

 

 

• Wall Height (ft) - Provide the height of the wall (ft) as measured 
from the sill to the top of the footing. 

• Depth Below Grade (ft) - Provide the depth (ft) that the wall 
extends from the outside finished grade surface to the top of the 
footing. 
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• Depth of Insulation (ft) - Provide the depth (ft) of the insulation 
you intend to install as measured from the top of the wall to 
where the insulation stops.  This distance should include the 
total vertical plus horizontal distance.  Because the horizontal 
distance is included, the depth of insulation may be greater than 
the height of the wall.  If you enter a depth of 0, the program 
assumes no insulation is to be installed. 

• Inside Depth Below Grade (ft) - Provide the depth (ft) as 
measured from the inside grade to the top of the footing. 

• Gross Area - Enter the gross area of the crawl space wall 
component in the Gross Area field.  The area should include the 
area of the entire wall as measured from the sill to the top of the 
footing, even if only a portion of the wall is insulated. 

• Cavity Insulation R-Value - Provide the R-value of any 
insulation to be installed between structural members in the 
Cavity Insulation R-Value field.  Do not include the R-value of 
other materials. 

• Continuous Insulation R-Value - Continuous insulation 
includes exterior rigid foam products and any continuous 
insulation installed on the exterior or interior of the wall.  For 
ICFs, enter the manufacturer-reported R-value for the entire 
assembly in the Continuous Insulation R-Value field. 
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Mechanical Equipment 
The buttons on the Mechanical screen are used to enter the HVAC 
equipment in your proposed design.  Completion of this section of the 
software is entirely optional.  However, using high-efficiency HVAC 
equipment may improve the percentage by which your building 
compares with the code building.  The message at the bottom of the 
screen explains what type of information goes into the currently 
selected field.  

Alterations to Mechanical Systems 

Under the 2006 IECC, changes to mechanical systems should be 
included but will not be considered in tradeoff calculations.  To 
consider mechanical system changes in tradeoff calculations, the entire 
building must be specified as New Construction (i.e., new building) 
scenario on the Project screen. 

Mechanical Equipment Not Listed 

Some equipment is not listed on the Mechanical screen.  The software 
does not allow tradeoffs for ground source heat pumps, forced hot 
water, and some other systems in the Mechanical screen.  The 
software does allow tradeoffs with air source heat pumps, fossil fuel 
furnaces, boilers, and air conditioners. 

Note, however, that you do NOT have to enter mechanical equipment 
information at all unless you are using such equipment in a tradeoff. 
 Simply do not fill out the Mechanical screen at all - the software will 
judge compliance based only on your envelope inputs. 

Although mechanical information is not required in the software, 
building codes do have requirements for mechanical equipment, which 
may include sizing, thermostats, piping insulation, and others.  Such 
requirements are listed in the software's Inspection Checklist. 

If you are installing a system that is not handled in the software, you 
should do three things to help your code official. 
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1. Make a note in the Project screen that gives your mechanical 
system specifics. 

2. Attach documents to your compliance report that provide 
information about equipment type, efficiency, installation, and 
sizing. 

3. Meet the appropriate requirements for the mechanical code in 
your area. 

Why Some Mechanical Equipment is not Listed 

The software makes only the most common equipment types available 
for tradeoff (those types which are covered by Federal appliance 
standards and are rated with an AFUE, SEER, or HSPF).  Other 
systems such as radiant floors, geothermal heat pumps, evaporative 
coolers, and others require complex calculations not available in 
REScheck.  These systems can receive tradeoff credit only through a 
whole-house performance (i.e., Chapter 4) analysis. 

You may consider using another software tool to do full performance 
analyses.  If you use an energy simulation approach with a high-
efficiency equipment type, be aware that you are reducing your 
building envelope energy efficiency while increasing equipment 
efficiency.  It may be better to increase both the equipment efficiency 
and the building envelope energy efficiency. 

HVAC Efficiency 
Trade-offs are allowed for efficient gas and oil furnaces, boilers, and 
electric heat pumps and air conditioners.  No credit is given for electric 
resistance heating.  Mechanical systems entered in REScheck should 
be the primary HVAC system to heat and cool the home.  Emergency 
back up heat is not the primary heating source for the building and 
should not be entered in REScheck.  No credit should be given for 
emergency back up heat. 

Minimum-required heating and cooling equipment efficiencies are 
displayed in the Minimum Efficiency column.  If the efficiency of the 
equipment you plan to install exceeds these minimums, you qualify for 
the high-efficiency equipment credit.  Enter the annual fuel utilization 
efficiency (AFUE), heating seasonal performance factor (HSPF), or 
seasonal energy efficiency ratio (SEER) in the appropriate column. 
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Multiple Pieces of Equipment 

You can receive credit for only one piece of heating equipment and one 
piece of cooling equipment (or a single heat pump).  When multiple 
heating equipment or multiple cooling equipment is entered, the least 
efficient equipment will be used to determine compliance.  However, if 
two furnaces having different efficiencies will be installed, you may 
create a single furnace entry and enter the average efficiency of both 
units in the Heating Efficiency field.  In this case, modify the output 
report to indicate that the reported efficiency is an average.  Enter the 
make and model number of BOTH pieces of equipment on the line 
provided in the Inspection Checklist portion of the output report.  The 
high-efficiency equipment credit is applied as a percent increase in the 
code house UA.  To see how much credit you are getting, observe the 
UA value displayed in the Max. UA field.  The UA will probably be 
smaller before taking the credit than after.  Some locations along the 
California coast do not qualify for the cooling equipment credit. 

New York:  The New York residential code does not give additional 
credit for heat pumps. 

Wisconsin:  The Wisconsin residential code requires furnaces (non-
electric) to have an efficiency rating of 90% or better to receive credit. 
 Buildings heated with heat pumps are treated like homes with 
electric resistance heating.  However, credit is given for heat pumps 
with HSPF ratings of 7.8 or better.  Boiler systems receive credit for 
any value above 80%. 

2006 IECC, Pima County, New Hampshire, or Georgia:   When 
any of these codes is the selected code and high-efficiency mechanical 
equipment has been entered, two separate calculations are performed 
when the Check Compliance button is clicked - the UA calculation and 
a performance calculation based on Section 404 of the code.  The 
latter is used only when compliance by total UA fails.  REScheck 
cannot be used to determine compliance for houses with multiple 
heating or cooling equipment.  High efficiency equipment tradeoff is 
available only for single-zone systems.  For houses with multiple 
heating or cooling equipment, use a performance-based compliance 
tool. 
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Wisconsin Heating Loads 
The Wisconsin residential code requires a load calculation for sizing the 
heating equipment of the building.  In the Loads screen, enter values 
for the floor area, ceiling height, infiltration rate, and oversizing 
factor.  Once these values are entered into the software, the Total 
Building Heating Load is calculated and can be used for selecting 
properly sized heating equipment.  The total building heating load is 
the sum of the loads from the assemblies entered in the Envelope 
screen (Conductive Losses), the infiltration loads (Infiltration Losses), 
and the loads resulting from the oversizing factor (Oversizing Factor 
Losses). 

• Conditioned Floor Area - The conditioned floor area includes 
the gross floor area of all heated rooms, including heated 
basement floor area. 

• Average Ceiling Height - The average ceiling height is the area-
weighted average height of the ceiling as measured from the 
finished floor to the underside of the ceiling. 

• Infiltration Rate - The infiltration rate is the normalized air 
changes per hour that is anticipated for your building.  The 
software will not accept values above 0.5 ACH or below 0.20 
ACH. 

• Equipment Oversizing Factor - The equipment oversizing factor is 
a percentage indicating the amount of oversizing you desire in 
selecting your heating equipment.  The software will not accept 
values over 15%. 





 

Menus 
The menu bar located at the top of the screen is used to select the 
File, Edit, View, Options, Code, Tools, and Help menus. 

File Menu 
The data you enter into REScheck can be stored on your hard drive in 
a project data file.  Separate data files can be created for different 
building projects or for alternate designs of the same project.  Data 
files allow you to retrieve and alter designs at any time.  Report files 
allow you to print the information you have entered and to document 
the compliance results determined by REScheck.  The File menu 
contains options allowing you to create (New), retrieve (Open), and 
save (Save, Save As) project data files and to print (View/Print) 
project reports. 

Data files created by REScheck must have the extension .RCK.  If you 
prefer, when you are asked to provide a filename, you may leave the 
extensions off and let REScheck enter them for you. 

 

 New - The New option allows you to erase the current data and 
begin a new project data file.  When you select New and unsaved data 
exists, REScheck asks if you wish to save the current data.  Select Yes 
to save the current data or No if you do not want to save the current 
data.  If you select Yes and a file is already open, the open file is 
updated to contain the current data.  If no file is open, the Files screen 
appears and you are asked for a filename to which the data will be 
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saved.  You can also open a new file by selecting the corresponding 
icon from the toolbar.  

 Open - When you want to revise or examine an existing file, you 
must retrieve a copy of the file by bringing it to the screen.  This is 
referred to as opening the file.  The Open option allows you to open an 
existing project data file.  When you select Open, the Files screen 
appears and you are asked for the filename of the project data file to 
retrieve.  If unsaved data exists, you are asked if you wish to save the 
current data before opening the new file.  If an unsaved file is already 
open, you are asked if you wish to save the currently open file before 
opening the new file.  You can also open an existing file by selecting 
the corresponding icon from the toolbar. 

Open Recent - The Open Recent option allows you to quickly access 
the most recently opened files. 

 Save - The Save option allows you to save your current data to 
the filename shown on the title bar.  If no file is open, the Files screen 
appears and you are asked for a filename.  You can also save data by 
selecting the corresponding icon from the toolbar. 

Save As - The Save As option allows you to save your current project 
data file to a new name.  This option is useful when an existing file is 
opened then modified.  If you want to save copies of both the original 
and the modified file, use Save As to rename the modified file. 

 View/Print Report - This option allows you to view and/or print a 
report listing project data and compliance results.  A popup window is 
displayed from which you can elect to print a Compliance Report, an 
Inspection Checklist, or both.  After choosing the report types to print, 
the .pdf will appear allowing you to print.  You can also print reports 
by selecting the corresponding icon from the toolbar. 

2006 IECC, Pima County, New Hampshire:   When any of these 
codes is the selected code, a third report option appears, Panel 
Certificate.  This panel certificate lists the predominant insulation R-
values, window U-factors, type and efficiency of space conditioning 
and water heater equipment.  To comply with the 2006 IECC, this 
certificate must be posted on or near the electrical distribution panel. 
 It is designed to be printed on an adhesive label but can also be 
printed on standard paper, trimmed, and affixed to the panel. 
 Georgia:  When Georgia is the selected code, a third report option 
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appears, Panel Certificate.  This page directs users to a website where 
the required certificate information can be completed. 

Save Report - This option allows you to save a report to a file.  A 
popup window is displayed from which you can elect to generate a 
Compliance Report, an Inspection Checklist, or both.  You also have 
the option to create the report in Rich Text Format (RTF), which can be 
loaded into most text processing software.  After choosing the report 
types, the Save Report dialog box will appear allowing you to provide a 
name for the file.   

Email Report - This option allows you to email a pdf and/or rtf version 
of the report to your local building department if they accept files in 
this manner.  To use this feature, select the items you want to email, 
provide information such as:  Permitting Facility, Facility Email 
Address, Your Name, and Your Email Address and click Send.  

Exit - The Exit option allows you to exit REScheck. 

Edit Menu 
Use the Edit menu to cut, copy, and paste data in editable fields, and 
to delete and duplicate entire rows.  Editable fields include: 

• The Project Details fields on the Project screen 

• All black-on-white (or red-on-white) fields in the tables on the 
Envelope and Mechanical screens 

• The tree component labels corresponding to these tables when in 
edit mode (tree labels are put into edit mode by double-clicking 
on them).   
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 Cut - The Cut option will delete highlighted text in an editable field 
and copy it to the clipboard.  The deleted text can be pasted into 
another editable field.  You can also cut text by selecting the 
corresponding icon from the toolbar. 

 Copy - The Copy option will copy highlighted text in an editable 
field to the clipboard.  The copied text can be pasted into another 
editable field.  You can also copy text by selecting the corresponding 
icon from the toolbar. 

 Paste - The Paste option will paste the last cut or copied text into 
the selected field at the current cursor location.  You can also paste 
text by selecting the corresponding icon from the toolbar. 

 Delete Row(s) - The Delete Row(s) option will delete all selected 
rows.  To select a row, click on the tree label corresponding to that 
row or click on the leftmost column of that row (the column containing 
row numbers).  Multiple consecutive rows can be selected by holding 
down the Shift key and clicking the left mouse button on the left-hand 
column on the desired rows.  Non-consecutive rows can be selected by 
holding down the Ctrl key while clicking on the leftmost column of 
each row to be selected.  You can also delete rows by selecting the 
corresponding icon from the toolbar. 

 Duplicate Row(s) - The Duplicate Row(s) option will duplicate one 
or more consecutive selected rows.  If non-consecutive rows are 
selected, this option will be disabled.  To select a row, click on the tree 
label corresponding to that row or click on the leftmost column of that 
row (the column containing row numbers).  Multiple consecutive rows 
can be selected by holding down the Shift key and clicking the left 
mouse button on the left-hand column on the desired rows.  You can 
also duplicate rows by selecting the corresponding icon from the 
toolbar. 

Preferences - Preferences allows you to set certain software options. 
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View Menu 

 

Toolbar - Toggle the Toolbar option to display and hide the toolbar at 
the top of the screen. 

Status Bar - Toggle the Status Bar option to display and hide the 
status bar at the bottom of the screen. 

2006 IECC, Pima County, New Hampshire, or Georgia:  When 
any of these codes is selected, the Glazing Requirements screen 
shows the maximum U-factor and SHGC requirements allowed by the 
2006 IECC.  The screen displays the maximum U-factors for vertical 
fenestration and skylights and compares these to the area-weighted 
average U-factors for your proposed components.  If the area-
weighted average U-factors of your glazing components exceed any of 
the maximums on this screen, your building will not comply.  The 
screen also shows the maximum area-weighted SHGC allowed by the 
code.  

2006 IRC:  The Glazing Requirements screen shows the maximum U-
factor and SHGC requirements allowed by the 2006 IRC.  The screen 
displays the maximum U-factors for vertical fenestration and skylights 
and compares these to the area-weighted average U-factors for your 
proposed components.  If the area-weighted average U-factors of your 
glazing components exceed any of the maximums on this screen, your 
building will not comply.  The screen also shows the maximum area-
weighted SHGC allowed by the code.  SHGC requirements are 
applicable only for Climate Zones 1-3 and Skylight requirements are 
applicable only for Climate Zones 4-8.  NA is displayed when the 
requirements are not applicable. 

Minnesota:  The R-Value/U-Factor Requirements screen shows the 
maximum U-factor requirements allowed by the Minnesota residential 
code.  The screen displays the maximum U-factors for glazing and 
floors and compares these to the area-weighted average U-factors for 
your proposed components.  If the area-weighted average U-factors of 
your glazing or floor components exceed any of the maximums on this 
screen, your building will not comply.  If the glazing U-factor 
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maximum is exceeded, the Compliance field will display the message 
Glazing Exceeds Maximum in red letters.  If the floor U-factor 
maximum is exceeded, the Compliance field will display the message 
Floor Uo Exceeds Maximum in red letters. 

Options Menu 

 

Two additional items may also appear depending on location 
and the code selected.  In locations less than 3500 HDD when 
any of the following codes is selected:  1998 IECC, 2000 IECC, 
or 2003 IECC, or in any location when Pima County, Arizona 
less than 4000 ft, Georgia, 2006 IECC, or New Hampshire is 
selected:  

• Orientation (Envelope) - Select this to enable the Front Faces 
drop list for the building and create the Orientation column for 
walls, windows, doors, and basement walls.  For walls, use the 
Orientation column to select the wall’s orientation relative to the 
front of the building.  To orient the right and left side of the 
building visualize yourself inside the building facing the front. 
 Any windows or doors entered belonging to a wall with a set 
orientation will have the same orientation as the parent wall. 

• Front Faces represents the angle of the front face of the building 
relative to North.  If the building front faces North, the building 
orientation will be 0 degrees; if the building front faces East, this 
will be 90 degrees and so on.  Select one of the eight cardinal 
points in the drop list or choose Custom.   Custom allows the 
user to specify an angle (in degrees) by rotating the building 
using a diagram.   

Locations less than 3500 HDD when 1998 IECC, 2000 IECC, or 
2003 IECC is selected:  

• Overhang Projection Factor (Envelope) - If an overhang exists, 
select this to create the Overhang Projection Factor column. 
 Enter the overhang’s projection factor (ratio of the overhang 
width to the overhang height above the window sill). 
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Comments/Description (Envelope) - Select this option to create a 
Comments/Description column on the Envelope screen.  Use the 
Comments/Description column to type additional information about a 
building assembly that you wish to be included in the Inspection 
Checklist, such as its location.  The blank Comment lines provided in 
the Inspection Checklist are replaced with any text entered in this 
column. 

Code Menu 
The Code menu is used to select the code edition applicable to your 
jurisdiction. 

 

Use Find Your Code to access the Building Energy Codes Program's 
Status of State Codes database to determine which energy code is 
application in your location. 
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Tools Menu 

 

AreaCalc Take-Off Tool - This option launches the AreaCalc software 
tool that can be used to do building take-offs.  The areas computed in 
AreaCalc can be transferred directly to REScheck. 

Help Menu 
The Help menu provides general information on how to use REScheck. 
  

 

Help Topics - The Help Topics option displays the help topics available 
for REScheck. 

Check for updates - If your computer is connected to the Internet, the 
software will check to see if there is a newer version of REScheck 
available from the REScheck website. 

About REScheck - The About REScheck option displays the program's 
version number and release date. 

Context Menu 
Clicking the right mouse button on a tree component label or table 
displays a pop-up list, referred to as a context menu.  The context 
menu options are applied to a single field in a table or to an entire row 
in a table, depending on where the mouse is clicked.  If the mouse is 
clicked on a tree component label, the menu options are applied to the 
row corresponding to that label.  If the mouse is clicked on the left 
field of a row in a table, the row is selected and the options are applied 
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to the entire row.  Some options are applicable to individual fields of a 
table, and the mouse must be clicked on the given field to activate the 
option. 

Cut, Copy, Paste - The Cut, Copy, and Paste options are available from 
the Edit menu in the menu bar, from toolbar buttons, and from the 
context menu.  See the Edit Menu section for a description of these 
options.  The Cut, Copy, and Paste options are applied to individual 
fields in a table.   

Duplicate Row(s), Delete Row(s) - The Duplicate Row(s) and Delete 
Row(s) options are available from the Edit menu, the toolbar, and the 
context menu.  See the Edit Menu section for a description of these 
options.  The Duplicate Row(s) and Delete Row(s) options apply to 
selected rows.    

Select Default - The Select Default option enables you to enter a 
default U-factor for windows, skylights, and doors that do not have an 
NFRC rating.  The Select Default option can be selected by clicking the 
right mouse button in the U-Factor column of any window, skylight, 
or door assembly.  A table of default U-factors based on 
characteristics of the given assembly will be displayed.  Choose the U-
factor corresponding to the characteristics of your assembly, then 
select the OK button to transfer this default to the table on the 
Envelope screen. 

Edit Text - The Edit Text option is used to edit the text on a tree label. 
 When you create a new envelope assembly, a new row appears in the 
corresponding table and a new tree label appears on the tree to the 
left.  The tree labels are assigned default names such as Ceiling 1. 
 These labels can be changed by clicking the right mouse button on the 
label and selecting Edit Text from the Context menu.  An edit box will 
become visible where the label used to be, and you can rename the 
label by typing in the edit box.  Press Enter or click elsewhere when 
finished.  You can enter a maximum of 128 characters in the edit box. 
 You can also edit tree labels by double-clicking on the label. 

Edit Inputs - Basement wall , crawl space wall, and slab-on-grade 
assemblies display screens which illustrate dimensions being requested 
of the user.  You may enter these dimensions directly into the 
illustration, then select the OK button to transfer them to the table on 
the Envelope screen.  You may change any previously entered 
dimensions directly on the table, or you may use the Edit Inputs option 
to redisplay the illustration with the previously entered values.  The 
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Edit Inputs option can be selected by clicking the right mouse button 
on the tree label or table row of any basement wall, crawl space wall, 
or slab assembly.  The option name in the context menu changes to 
Edit Basement Inputs, Edit Crawl Inputs, or Edit Slab Inputs, 
depending on the row being selected. 

Locations less than 3500 HDD when 1998 IECC, 2000 IECC, or 
2003 IECC is selected:  

Edit Overhang Ratio - An Overhang Projection Factor illustration 
displays the entries needed to calculate the overhang ratio.  You may 
enter this information directly into the illustration, then select the OK 
button to transfer the calculated ratio to the Envelope screen.  You 
may change the previously entered ratio directly on the table, or you 
may use Edit Overhang Ratio to redisplay the illustration with the 
previously entered values. 



 

Changing Location Files 
The following text provides instructions for changing from the city 
version of the REScheck software to the county version. 

The REScheck software contains two location files: 

1. CITIES.dat contains a list of cities for each state. 

2. COUNTIES.dat contains a list of counties for each state. 

The useCounties variable contained in the CHECK.PRP file determines 
which of these location files is used by the software.  To modify this 
variable, open the CHECK.PRP file in a text processor (preferably 
NOTEPAD) and set useCounties to true or false.  By default, the 
software uses cities: 

useCounties=false 

You MUST save this file in an ASCII text format.  The best text 
processor to accomplish this is NOTEPAD.  

Noteworthy: 

If you have saved a data file for a building, the location for that 
building is also saved.  If you subsequently change the location file as 
described above and try to load that data file back into the REScheck 
software, REScheck will not find the specified building location and will 
set the location to a default.  Therefore, after loading the file into the 
program, you must go back to the Project screen and reselect your 
location. 
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Glossary 

A 
addition: An extension or increase in the height, conditioned floor 

area, or conditioned volume of a building. The code applies to 
additions of existing buildings. 

AFUE: Annual fuel utilization efficiency; combustion heating 
equipment efficiency is expressed in terms of AFUE. New 
equipment typically ranges from about 78- to 96-percent AFUE. 
Higher AFUE ratings indicate more efficient equipment. 

alteration: Any construction renovation, or change in a mechanical 
system that involves an extension, addition, or change to the 
arrangement, type, or purpose of the original installation. 

B 
basement wall: Basement walls that enclose conditioned spaces are 

part of the building envelope. Basement wall refers to the 
opaque portion of the wall (excluding windows and doors). To be 
considered a basement wall, at least 50% of the wall’s total wall 
area (including openings) must be below grade. Treat walls on 
each side of the basement individually when determining if they 
are above grade or basement walls. For any individual wall less 
than 50% below grade, include the entire opaque wall area of 
that individual wall as part of the above-grade walls. 

building envelope: All components of a building that enclose 
conditioned space. Building envelope components separate 
conditioned spaces from unconditioned spaces or from outside 
air (see conditioned space). For example, walls and doors 
between an unheated garage and a living area are part of the 
building envelope; walls separating an unheated garage from the 
outside are not. Although floors of conditioned basements and 
conditioned crawl spaces are technically part of the building 
envelope, the code does not specify insulation requirements for 
these components and they can be ignored. 

C 
cavity insulation: Insulation installed between structural members. 

REScheck User’s Guide, October 2008 61 



REScheck Software User's Guide 

ceiling: The ceiling requirements apply to portions of the roof and/or 
ceiling through which heat flows. Ceiling components include the 
interior surface of flat ceilings below attics, the interior surface of 
cathedral or vaulted ceilings, skylights, or vaulted ceilings, 
skylights and sloped building assemblies less than 60 from 
horizontal, but excluding skylight shafts. Refer to Building 
Envelope Components in Appendix C for a comprehensive list of 
ceiling components. 

conditioned floor area: The conditioned floor area includes the gross 
area of all heated and/or cooled rooms,including the floor area of 
heated or cooled basements. 

conditioned space: A space is conditioned if heating and/or cooling is 
deliberately supplied to it or is indirectly supplied through 
uninsulated surfaces of water or heating equipment; uninsulated 
ducts; or uninsulated floors, ceilings, or walls between it and 
another conditioned space. For example, a basement is 
conditioned if: 1) it has registers or heating devices designed to 
supply heat, or 2) the basement ceiling is not insulated and the 
space above it is conditioned, or 3) the space contains 
uninsulated ducts or uninsulated surfaces of water heaters or 
space heating equipment. 

continuous insulation: Insulation that runs continuously over 
structural members and is free of significant thermal bridging; 
such as rigid foam insulation above the ceiling deck. 

cooled: A space within a building which is provided with a positive 
cooling supply. 

crawl space: The REScheck crawl space wall insulation requirements 
are for the exterior walls of unventilated crawl spaces (i.e. not 
directly vented to the outside) below uninsulated floors. A crawl 
space wall component includes the opaque portion of a wall that 
encloses a crawl space and is partially or totally below grade, as 
measured from the sill to the top of the footing. 

crawl space wall: The opaque portion of a wall which encloses a 
crawl space and is partially or totally below grade. 

D 
door: Doors include all openable opaque assemblies located in exterior 

walls of the building envelope. Doors with glass can be treated 
as a single door assembly, in which case an aggregate U-factor 
(a U-factor that includes both the glass and the opaque area) 
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must be used; OR the glass area of the door can be included 
with the other glazing and an opaque door U-factor can be used 
to determine compliance of the door. 

dwelling unit: A single housekeeping unit of one or more rooms 
providing complete, independent living facilities, including 
permanent provisions for living, sleeping, eating, cooking, and 
sanitation. 

E 
equipment efficiency: The measure of equipment efficiency varies 

with equipment type. Combustion heating equipment efficiency 
is expressed in terms of annual fuel utilization efficiency (AFUE). 
New equipment typically ranges from about 78- to 96-percent 
AFUE. Cooling efficiency for electric air conditioners and heat 
pumps is expressed in terms of seasonal energy efficiency ratio 
(SEER). New equipment ranges from 10 to about 16 SEER. Heat 
pump heating is expressed in terms of heating seasonal 
performance factor (HSPF). New equipment ranges from about 
6.8 to 10.0 HSPF. Higher AFUE, SEER, and HSPF ratings indicate 
more efficient equipment. 

F 
floors over outside air: include floor cantilevers, floors of an 

elevated home, and floors over overhangs (such as the floor 
directly above a recessed entryway or open carport) 

floors over unconditioned space: include all floors over 
unconditioned (neither heated nor cooled) basements, crawl 
spaces, and garages 

G 
glazing: Any translucent or transparent material in exterior openings 

of buildings, including windows, skylights, sliding doors, the 
glass area of opaque doors, and glass block. 

glazing area: The area of a glazing assembly is the interior surface 
area of the entire assembly, including glazing, sash, curbing, and 
other framing elements. The nominal area or rough opening is 
also acceptable for flat windows and doors. 

gross wall area: The gross wall area includes the opaque area of 
above-grade walls, the opaque area of any individual wall of a 
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conditioned basement less than 50% below grade (including the 
below-grade portions), all windows and doors (including windows 
and doors of conditioned basements), and the peripheral edges 
of floors. 

H 
heated: A space within a building which is provided with a positive 

heat supply. 

heating degree days: A unit, based upon temperature difference and 
time, used in estimating fuel consumption and specifying 
nominal heating load of a building in winter. For any one day, 
when the mean temperature is less than 65F (18C), there exists 
as many degree days as there are Fahrenheit degrees difference 
in temperature between the mean temperature for the day and 
65F (18C). 

HSPF: Heating seasonal performance factor; heat pump heating is 
expressed in terms of HSPF. New equipment ranges from about 
6.8 to 10.0 HSPF. Higher HSPF ratings indicate more efficient 
equipment. 

I 
IECC: International Energy Conservation Code 

M 
MEC: Model Energy Code 

multifamily: A multifamily building is a residential building three 
stories or less in height that contains three or more attached 
dwelling units. Multifamily buildings include apartments, 
condominiums, townhouses, and rowhouses. Hotels and motels 
are considered commercial rather than residential buildings. 

N 
NAECA: The National Appliance Energy Conservation Act of 1987, 42 

USC 6291 et seq., as amended, Public Law 100-12. 

net wall area: The net wall area includes the opaque wall area of all 
above-grade walls enclosing conditioned spaces, the opaque 
area of conditioned basement walls less than 50% below grade 
(including the below-grade portions), and peripheral edges of 
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floors. The net wall area does not include windows, doors, or 
other such openings, as they are treated separately. 

O 
opaque areas: Opaque areas referenced in this guide include all 

areas of the building envelope except openings for windows, 
skylights, doors, and building service systems. For example, 
although solid wood and metal doors are opaque, they should 
not be included as part of the opaque wall area (also referred to 
as the net wall area). 

P 
panel certificate: 2006 IECC or Pima County (other than SES): This 

certificate lists the predominant insulation R-values, window U-
factors, typeand efficiency of space conditioning and water 
heater equipment. To comply withthe 2006 IECC, this certificate 
must be posted on or near the electrical distributionpanel. It is 
designed to be printed on an adhesive label but can also be 
printedon standard paper, trimmed, and affixed to the panel. 

R 
R-value: A measure (h ft2 F/Btu) of thermal resistance, or how well a 

material or series of materials resists the flow of heat. R-value is 
the reciprocal of U-factor. 

raised truss: Raised truss refers to any roof/ceiling construction that 
allows the insulation to achieve its full thickness over the plate 
line of exterior walls. Several constructions allow for this, 
including elevating the heel (sometimes referred to as an energy 
truss, raised-heel truss, or Arkansas truss), use of cantilevered 
or oversized trusses, lowering the ceiling joists, or framing with 
a raised rafter plate. 

RECD: The Rural Economic and Community Development, formerly the 
Farmer’s Home Administration. 

repair: A repair includes the reconstruction or renewal of any part of 
an existing building for maintenance purposes. 

residential buildings: For the purposes of the code, Group R 
residential buildings include: Type A-1 – Detached one- and two-
family dwellings; and Type A-2 – All other residential buildings, 
three stories or less in height 
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S 
SEER: Seasonal energy efficiency ratio; cooling efficiency for electric 

air conditioners and heat pumps is expressed in terms of SEER. 
New equipment ranges from about 13 to 16 SEER. Higher SEER 
ratings indicate more efficient equipment. 

SHGC: Solar heat gain coefficient; SHGC is the glazing’s effectiveness 
in rejecting solar heat gain. SHGC is part of a system for rating 
window performance used by the National Fenestration Rating 
Council (NFRC). SHGC is gradually replacing the older index, 
shading coefficient (SC), in product literature and design 
standards. If you are using glass whose performance is listed in 
terms of SC, you may convert to SHGC by multiplying the SC 
value by 0.87. 

single family: A detached one- and two-family residential building, 
irrespective of height. 

skylight: Glazing that is horizontal or sloped at an angle less than 60 
(1.1 rad) from horizontal. 

slab edge: Slab edge refers to the perimeter of a slab-on-grade floor, 
where the top edge of the slab floor is above the finished grade 
or 12 in. or less below the finished grade. The slab perimeter 
should include the length of all edges of a slab foundation that 
are part of the building envelope and are less than 12 in. below 
grade (i.e. all edges separating conditioned space from 
unconditioned space). The insulation can be installed using any 
of the following configurations, but in all cases it must start at 
the top of the slab: The slab insulation extends from the top of 
the slab downward to the required depth. The slab insulation 
extends from the top of the slab downward to the bottom of the 
slab and then horizontally underneath the slab for a minimum 
total linear distance equal to or greater than the required length. 
The slab insulation extends from the top of the slab downward to 
the bottom of the slab and then horizontally away from the slab 
for a minimum total linear distance equal to or greater than the 
required depth. The horizontal insulation must be covered by 
pavement or at least 10 in. of soil. The top edge of insulation 
installed between the exterior wall and the interior slab can be 
cut at a 45 angle away from the exterior wall. 

slab-on-grade floor: A floor that is poured in direct contact with the 
earth. 
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U 
U-factor: A measure (Btu/h ft2 F) of how well a material or series of 

materials conducts heat. U-factors for window and door 
assemblies are the reciprocal of the assembly R-value. 

UA: U-factor X Area; REScheck performs a simple UA calculation for 
each building assembly to determine the overall UA of your 
building. The UA that would result from a building conforming to 
the code requirements is compared against the UA for your 
building. If the total heat loss (represented as a UA) through the 
envelope of your building does not exceed the total heat loss 
from the same building conforming to the code, then the 
software declares that you pass. A high-efficiency equipment 
trade-off can also be performed. 

unconditioned: An enclosed space within a building that is not a 
conditioned space. 
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